CS 10:

Problem solving via Object Oriented
Programming

Introduction



» 1. You, me, and this course
2. Why Object-Oriented Programming (OOP)
3. Javaintro
4. Variables

5. Arrays



Let’s start with our backgrounds

Your background

How did you satisfy the pre-reqs?

e CS1

* ENGS 20

e AP/department exam
e Other

Your plans?

If you never take another CS class, |
hope you’ll be a better consumer of
computer scientist’s/data scientist’s
work products

CS majors? Minors? Not sure? Other?

My background



This course is about solving problems with

OOP, not simply how to program in Java

* Focus will be on solving problems with Object Oriented
Programming (OOP), and you’ll learn some Java along the way

 OOP is not the only way to solve problems, but it can be useful

* The course has three main components that overlap somewhat:
1. Object Oriented Programming concepts and Java basics

2. Abstract Data Types (ADTs) such as queues, stacks, trees, and
graphs that form building blocks for solving problems (you’ll see
these ADTs again and again in CS)

3. Solving wide range of real problems (graphics manipulation,
characterize social networks, play Kevin Bacon game, compress

files, analyze text...)

* You will learn far more by actually implementing things than you
4
will by simply reading the material or only attending lectures



Material will be covered in lecture, section

meetings, homework, and exams

Syllabus: http://www.cs.dartmouth.edu/~tjp/cs10

ASSESSMENT

Section (Recitation) meetings

Homework
e Short assignments (SA): 10%
* Problem sets (PS): 25%

Exams

e Midterml: 20%
e Midterm2: 20%
* Final: 20%

Textbook:

Data Structures &
Algorithms in Java ,
6" ed, by Goodrich,
Tamassia, and
Goldwasser

Lectures
e Stay home if sick
 Show up on time

LLMs
See course web site


http://www.cs.dartmouth.edu/~tjp/cs10

We will also be using Canvas and Slack for

announcements and help

Canvas
* Course announcements and
homework submissions
* Section assignments

Slack (access via Canvas)
e Q&A forum
 Ask questions, get answers
e Don’t post code!

Let me know if you don’t have access

BLOPER

"The answers you seek can be found in the syllabus."
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Short Assignment O (SA-0) is out, complete

survey before 8:00am tomorrow

SA-0

Find assignment on Canvas

1. Take course survey to understand your background
and assign you to a section

2. Set up development environment
* [nstructions and screen shots provided on website
 We will use IntelliJ IDEA for this course

3. Create your first Java class

4. Read and acknowledge course policies and honor
code

Complete survey before 8:00am tomorrow (or risk

getting assigned to inconvenient section time!)




1. You, me, and this course

. Why Object-Oriented Programming (OOP)

3. Javaintro
4. Variables

5. Arrays



OOP relies on four main pillars to create
robust, adaptable, and reusable code

Abstraction

Name
functionality, not
how to
implement

Leads to Abstract
Data Types
(ADTSs)

Encapsulation
Bind code and data into one thing called an

object

QOP Pillars

Abstraction

T

£

Encapsulation

T

£

Code called methods in OOP (not functions)

Inheritance Polymorphism

’ Polymorphism
Same name,
many meanings

25 &8

Inheritance
* Create specialty versions that
“inherit” functionality of parent

9
e Reduces code



OOP is popular, especially in large

organizations

Top languages used in large organizations

Java

G
G
———

Python

0 10 20 30 40 50 60 70
Percentage of organizations using language

Source: https://www.cloudfoundry.org/wp-content/uploads/Developer-Language-Report_FINAL.pdf (Javascript omitted)

Each of the
most
common
languages is
object
oriented

Javais
particularly
popularin
large
organizations
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Why is OOP in general, and Java in

particular, so popular?

Approved answer: because it makes solving many types of
problems easy (or perhaps easier)

Paul Graham’s answer: it keeps mediocre programmers from
doing too much damage
* Inthe real world, on a single project you may have dozens
(or hundreds) of programmers working with thousands of
objects — no one knows them all

* People come and go during the course of a non-trivial
project — maintaining corporate knowledge is difficult

* We will see that objects can help prevent well-meaning
people from making costly mistakes

11



1. You, me, and this course
2. Why Object-Oriented Programming (OOP)

» 3. Javaintro Kevpont

Java is a compiled, strongly typed language

4. Variables

5. Arrays
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We will be using Java, these things may

blow your mind

Depending on your background, this may be weird:
e Must compile a program before it runs (so everything
must be syntactically correct ahead of run time)
 Declare variable and give them a type

* White space/brackets Onward to OOP glory!
* For-each loops - ;,,-; : '

Image: https://www.askideas.com/man-riding-giant-chicken-funny-picture/



In keeping with tradition, we’ll start with

“Hello world”
HelloWorld.java

1. Start Intelli), create “cs10” Java Project (only need to do this one time)
2. Create “dayl” Source folder to logically group your source code (e.g., “PS1” Source folder
holds all the source code for Problem Set 1)
3. Create new “HelloWorld” class in “day1” source folder
* File ondisk is “HelloWorld.java”
* Class Name is “HelloWorld”
* Intelli) “stubs” out “main” method (where program execution starts)

Other items of note:
Javadoc
* Java documentation feature
* Enter description for Class or method
e Starts with “/**” ends with “*/”
e Can add tags such as “@author” or “@param”
main() is where action starts
Add System.out.printin(“Hello World”) to output to the console
Right click on code and choose “Run <class name>.main()” button to run
14



1. Create “cs10” Project to hold source

code (only need to do this one time)

Start Intelli), then select “Create new project” or click File->New->Project

® @ New Project
Name: cs10
Mew Project — 2) ch
: oose
1) Enter gy - LT Location: ~[ldeaProjects J d
prOject name Ganerators Project will be created in: ~fldeaProjects/cs10 ava an
cs]_O M Maven Archetype Create Git repository Inte"l.’

4 Jakarta EE
o Spring Initializr
3 JavaFX
[®] Quarkus
Micronaut
. Ktor
[ Kotlin Multiplatform
Q@ Compose for Desktop
B HTML
React
ex Express
A Angular CLI
T IDE Plugin
= Android
¥ Vuejs
Vo Vite

? Cancel

Language: Java Kotli Groowy JawaScript +
Build system: IntelliJ Maven Gradle

JDK: [3 16 Oracle OpenJDK version 16.0.2  ~

Add sample code \
3) Choose

Generate code with onboarding tips
Java 16.02

Advanced Settings

4) Click
/ Create

"




2. Create Source folder to hold your source

code for day one of class

Click File->New->Directory to create directory for related code (e.g., “dayl” or “PS1”)

2) Give directory a name
1) Click File->New->Directory ) y

[ ] New Directory
\ er new directory name:
@ InteliJIDEA BiCW Edit View Navigate Code Analyze Refactor Build Run Tools VCS dav]
= ay’
Project...
& Open... Project from Existing Sources... cance! | ([ICTEIN
Open URL... Project from Version Control... >
Open Recent > lor
Close Project Module... - .
Module from Existing Sources... dayl : . %vﬁ
B Project Structure... 8; M o
3 iy da New > -
Other Settings B = File i 7
; = Scratch File d4a X Cut 8X o b public class H
Import Sett!ngs... ~ Directory a B Copy %C 10 )
Export Settings... E | Copy Path ) 795@8(2 JL.l > pnbl;:;::
Settings Repository... 2 HTML File da Copy Relative Path \G;C - ¥
Sync Settings to JetBrains Account... IR 4 14
Y g : & Stylesheet da - i }
Export Pro;fect .to Eclipse... CFML/CFC file da  Find Usages XF7 1o
Export to Zip File... 2 5 da  Find in Path... T ®F
is. JavaScript File da Replace in Path... {+#R
H Save All %8S = TypeScript File ) . . da  Analyze >
S Synchronize X ®Y @ package.json File 3) R |ght CI | Ck da  Refactor >
i Kotlin Script da
Invalidate Caches / Restart... K cOneesCr‘,);,t e 4l Add to Favorites N
ipt Fi .
o ‘A, da Show Image Thumbnails 38T
E_)(p:'ft tto il @ Gradle Kotlin DSL Build Script on ne 40 pocormat Cod ]
= Print... 7 X eformat Code
radle Kotlin DSL Settings d - -
e R directory  ©-a gmem k
F L elete...
: da
Remove BOM Edit File Templates... h I da  Build Module 'cs10*
t en Se eCt 93 Reveal in Finder
Line Separators > 7 Resource Bundle “ .da @ Open in Terminal
o & . : 1 Ing
Make Directory Read-only i;,i,‘;:"xrl\glr_nConf|guratlon File M a r k il Local History N
|  Power Save Mode 9 D. t m Sit ronire e >
»owwuayzs Data Source I rec or ou = Synchronize 'day
day24 y g: 4" Compare With... %D
day27 am New HTTP Request 14 d .
hoconxts a s a n ;)  Mark Directory as » Sources Root

ps  Remove BOM

Test Sources Root

Source folders are a useful way to “Sources Fe 2 Dsrams > T T e o
organize your code (ex. PS1 Source folder Root” g R R R e — ”

contains all code for Problem Set 1)



3. Create new “HelloWorld” class in “day1”

source folder

Right click on Source folder and select New->Java Class

2) Give class a name (starting with capital letter)

@ InteliJIDEA File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
eoe
= €s10  Iw dayl

Project ~ @B = & — @ Helloworldjava . E Create New CIHSS
a €s10 ~/Documents/ideaProjects/cs10 1 /%K )

idea 2 : Standard 'Helle Worlc Namﬂ: HE”GWGrld Ti

data 4 * @author Everyone who
W day1 2 _ e |

» { -
P New > JavaClass | Kind: £ Class B
@ 5lol ¢ cut 38 & Kotlin File/Class
= File

®8lo| B Copy #C | & scratch File oxn |

& Blo| Copy Reference X{#C & EXML File i

@ slol O Paste BV | & package-info.java

C:Hell Find Usages \CF7 | = module-info.java

€ Wel o

g Find in P?th..4 {+38F 2 HTML File

Y Replace in Path... O®R | Stylesheet ° . .

» 3) Intellil tes fil disk

e Analyze > | @ CFML/CFC file ) n e | Crea ES I e On IS e-g Y)
w day5 Refactor » s JavaScript File

= TypeScript File " I I Id H ”» d I

=95 | paq 1o Favortes 8@ pecisgesontls HelloWorld.java™) and sets up your new class

Zay; Show Image Thumbnails 8T = Kotlin Script

ay SR
w day9 Reformat Code NHLW & S::;e:xs::plti:::on

day10 Optimize Imports aoll ory singl i . . . . § . . ;
: Delete... ® | ™= Singleton @ IntelliJIDEA File Edit View Navigate Coi Analyze Refactor Build Run Tools VCS Window Help

dayn @ Gradle Kotlin DSL Build Script -

day12 Build Module 'cs10" @ Gradle Kotlin DSL Settings ece
Wdayl3  Repuild '<default>’ Q38F9  @m XSLT Stylesheet 510 | [ dayl | @@ HelloWorld

day14 [ . .
w dayis  Reveal in Finder Edit File Templates... I Project ~ © T | & — | '© HelloWorldjava

day16 Open in Terminal GUI Form E .1:51!::i -/Documents/ideaProj :1 . public class Helloworld {
Wday18 | ocal History > Create Dialog Class - dl ee 3 |

day19 gt > Form Snapshot ata
" day21 S synchronize 'day1’ /1 Resource Bundle day1

day22 i@ XML Configuration File > € Blob
w day23 +~ Compare With... #¥D Diagram > € Blob0

- G i € Blob01

day24  gpen Module Settings sy ] @ Cocgle Guice L N °

w day27 ; & Blob02
Mark Directory as > Data Source N

inputs Remove BOM < BlobDriver

libs - im New HTTP Request & BlobDriver2

mazes 1= Diagrams > — € HelloWorld

& HallnW nrldWith lauaNae

1) Right click on Source folder (e.g. “dayl”),
then select New->Java Class 17



Intelli) creates HelloWorld.java

“boilerplate” code

& IntelliJIDEA File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

= cs10 dayl ' (& HelloWorld

Project = 3 = &L — | © Helloworld.java

E 2 €510 ~/Documents/ideaProjects/cs10 : : public class Helloworld {
i .idea : I}
data _

da‘ﬁ;l i File on disk is HelloWorld.java

¥ Blobo Class is named HelloWorld
€ Blob01

£ Blob02

&' BlobDriver

&' BlobDriver2

£ HelloWaorld

18



We can flesh out the boilerplate code to

print “Hello World!” to the console

Execution begins at main() method
Type “main” then enter and IntelliJ expands to include the main method declaration

public :lasmd { public class Hello

y 'r::ﬂ T S public static void main(String[] args) {

Press ~. to choose the selected (or first) suggestion and insert a dot afterwards =»>

¥

In Java a print statement is System.out.printin(“text you want to print goes here”);
Type “sout” then enter to have IntelliJ fill out print statement for you (saves a lot of typing!)

public class/HelloWorld {
publickEtatic void main{String[] args) {

~ public class HelloWorld {
public static void main(String[] args) {

S0u
50u1[1 Prints a string to System.ou_ system.out.printin I-II-'I '
b soutm
soutp
SOUTV
Press ~. to choose the selected (or first) suggestion and insert a dot afterwards 2> i1

19



We can flesh out the boilerplate code to

print “Hello World!” to the console

/**
* Standard 'Hello World' first program

*

* @author Everyone who has ever written about programming and Tim Pierson too,

* Dartmout \ Javadoc

¥/ * Describes program (or method)
Begins with “/**” ends with “*/”

public class HelloWorld {
public static void main(String[] args) { Add tags such as
System.out.printin("Hello World!"); “@author” or “@param”

20



Running the program prints “Hello Worl

to console

% €510 ~/Documents/ideaProjec 1 FHE
idea 2 * Standard 'Hello World' first program
3 *
data 4 * @author Everyone who has ever written about programming and Tim Pierson too,
day1 5 * Dartmouth CS 10, Fall 2018
* _
€ Blob = Copy Reference X{#C
> -
& Blob0 & b _ public class HelloWorld { O Paste /Y . . .
& Blobo1 o b pubtic static void sain(Seringl) arac) ¢ Paste from History... 4y Run program by r|ght c||ck|ng
& Blob02 ﬁ System.out.printin({"Hello World!"}; Paste without Formatting eV
€' BlobDriver 12 1 Column Selection Mode {rate d I .
5D i on program text and selecting
& Helloworld o S "

€' HelloWorldWithJavaDoc o

€ Webcanes ; Faking Y “Run <class name>.main()”

day2 t:
daya ;[1 Go To >
daya 21 Generate... #EN
dayb Recompile 'HelloWorld.j3' O ¥F9
day6 Run 'Helloworld.main()
day7? # Debug "HelloWorld.main()" ~{D
day8 0. Run 'HelloWorld.main()' with Coverage
day9 .
dayl0 Save "HelloWorld.main()’
day11 Reveal in Finder
dayl12 & Open in Terminal
day13 .
dayla Lt?cal History >
dayls Git >
day16 I3 Compare with Clipboard
dayl8 File Encoding
day19 .
day21 5 D|agram§ >
day22 ©) Create Gist...
day23 WebServices >
day24
day27
inputs °
Output appears in console below
mazeSearch
out
pictures
PS-1
PS-2
Ps-3
PS-4
PS-5
PS-6
SA-1
cnn

un: SketchServer Editor

| /Library/Java/ . achines/jdk-12.0@.1.jdk/Contents/Home/bin/java “~javaagent:/Applications/Intellil IDEA.app/Contents/lib/idea_rt.ja

Hello World!

21

Process finished with exit code @



1. You, me, and this course
2. Why Object-Oriented Programming (OOP)

3. Java intro

. Key points:
. Varia b I @S 1. InJava we declare each variable and give it a data type

2. Data types cannot be changed

5. Arrays
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In Python we declare variables but do not

say what type of data they hold

Python example python_variables0.py
Code
print(x) Variable x is not defined, Python has no idea

what to print and gives an error message

Output

S python3 python_variables0.py

Traceback (most recent call last):
File "PythonVariables.py", line 2, in <module>
print(x)
NameError: name ‘X' is not defined

23



In Python we declare variables but do not

say what type of data they hold

Python example python_variables01.py
Code
X=5 Give a value to x and Python prints is value
print(x)

Note: you didn’t tell Python what type of data
x holds, just its value

Python guesses x is an integer based on the
value assigned (called dynamic or duck typing)

Output

S python3 python_variables01.py

5

24



Python’s type function tells us what kind of

data the variable holds

Python example python_variables02.py
Code

X=5 Confirm Python thinks variable x is an
print(x) integer by printing its data type
print(type(x))

Confirmed, Python thinks x is an integer

Output
S python3 python_variables02.py

5
<class 'int'>

25



In Python a variable’s data type can change

Python example python_variables03.py
Code

x=5 Python allows the type of a variable to change
print(x)

print(type(x)) Still guesses variable type based on value assigned
x = "Hello World"

print(x) Now Python thinks x is a String

print(type(x))

Output

S python3 python_variables03.py
5

<class 'int'>
Hello World
<class 'str'>

26



In Python a variable’s data type can change

Python example python_variables03.py
Code

x=5 Python allows the type of a variable to change

print(x)

print(type(x)) Still guesses variable type based on value assigned

x = "Hello World"

print(x) Now Python thinks x is a String

print(type(x)) Unlike Python we will tell Java

specifically what kind of data
a variable holds

Output i .
P Once we give a variable a

S python3 python_yariables03.py type, we can’t change it to a
5 different type later (e.g., an
<class 'int'> integer variable can’t become

Hello World a String variable in Java)
<class 'str'>

27



In Java, we explicitly say what type of data

a variable holds (and can’t change it later!)

Common primitive types

Type Description Size Examples
int Integer values (no decimal | 32 bits (4 bytes) -104,...1,2,3...107,...5032
component)
double | Double precision floating 64 bits (8 bytes) -123.45,1.6
point (has decimal
component)
boolean | true or false 1 bit true, false
char Characters 16 bits (2 bytes for ‘a’’b’,...7
Unicode)

Note: String are objects, not primitives
We will discuss objects next class

28



In Java, we explicitly say what type of data

a variable holds (and can’t change it!)

JavaVariablesO.java

Code

public class JavaVariablesO {
public static void main(String[] args) {

intx, <€
System.out.println("x = "+x);
}
}
Output

Java knows x is an integer because
we declare it as an integer

We say Java is “strongly typed”
because we tell Java what type of

data a variable holds

When a variable is declared Java
allocates memory for it

Here Java allocates memory for
one integer (4 bytes)

29



Java does not initialize local variables

JavaVariablesO.java
Code

public class JavaVariablesO {
public static void main(String[] args) { This code looks like it should run,

int x; but fails at compile time
System.out.printin("x = "+x);
} Why?
}
x is not given an initial value
It was also an error in Python
Output

when we didn’t give x a value
S javac JavaVariables0.java

JavaVariables0.java:4: error: variable x might not have been initialized

System.out.printin("x = "+x);
7A

1 error

30



Java tells us where to find errors, pay

attention to these hints when debugging!

JavaVariablesO.java

Code

public class JavaVariablesO {
public static void main(String[] args) { Note: Java tells us what file
int x; contained the error

System.out.println("x = "+x);

And also tells us what line number
Thanks Java!

}
}

Output

S javac JavaVariables0
JavaVariables0.java:4: error: variable x might not have been initialized

System.out.printin("x = "+_x);
7A

1 error

31



We must initialize local variables ourselves

JavaVariables01.java

Code

public class JavaVariablesO1 {

public static void main(String[] args) { o ) ]
Initialize x with an integer value

intx=5; e
System.out.printin("x = "+x);
}
} Note: javac from the command line

compiles file name provided

Creates a file with a .class extension with
Output the byte code (JavaVariablesO1.class here)
S javac JavaVariablesO1.java

S java JavaVariables01
x=5

\ java command runs the byte code (no need to

provide the .class file extension)

32



Initialization can happen after a variable is

declared

JavaVariables02.java

Code

public class JavaVariables02 {

public static void main(String[] args) { ] )
Not necessary to give local variables

int x; B
X=5; €— a value when declared
System.out.printin("x = "+x); ) ]
) Just give the variable a value before
} using it
Output

S javac JavaVariables02.java
S java JavaVariables02
x=5

33



Variables can only hold the type of data

they were declared to hold

JavaVariables03.java

Code

public class JavaVariables03 {

public static void main(String[] args) { ]
Variables must hold the type of data

int x;
x = "Hello world": / they were declared to hold

System.out.printin("x = "+x); o
Here we can’t store a String in an

}
) integer variable!
Java tells us where to find the error
Output (file name: line number)

S javac JavaVariables03.java
JavaVariables03.java:4: error: incompatible types: String cannot be converted to int

x = "Hello world";
N

1 error
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. You, me, and this course

2. Why Object-Oriented Programming (OOP)
3. Java intro
4. Variables  Keypoints:

1. Arrays are just a contiguous block memory,
(that’s all they are!)

. Arrays 2. Arrays are different from Java’s ArrayLists

and Python’s lists! We will soon see how
they are different 35



We can use multiple variables to store

multiple values

MulitpleVariables.java

Code
Say we wanted to track multiple quiz scores
public class MultipleVariables {
public static void main(Strinchan declare multiple variables on one line
int scorel =5, score2 =7;
System.out.printin(”scorel = "+ scorel + ", score2 =" + score2);
}
} Here both scorel and score2 are integers,
initialized with different values
This approach becomes cumbersome if we
Output want to track many values

S javac MultipleVariables.java
S java MultipleVariables
scorel =5, score2 =7
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Arrays provide a better way to store many

values in a contiguous block of memory

Code Index 0 1 2 3 4

public class MultipleVariablesArray { ‘ ‘ ‘ ‘
public static void main(String[] args) {
doublel] scores = new doubl store quiz scores
scores[0] = 10; //zero indexed T jﬁ,ﬁ Use an array to store multiple quiz scores
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8; Here enough room to hold 5 doubles

scores[4] = 8.8; //valid indices are 0.4 (5 doubles * 8 bytes/double = 40 bytes)
scores[5] =9; //error, index out of bounds!
System.out.println(scores); Arrays are zero-indexed in Java (unlike Matlab)

OS allocates a contiguous block of memory

Keyword new allocates memory for array (we
will see soon this is an object)
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Finding an index in an array is two math

operations: 1 addition and 1 multiplication

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 6.5 ‘
public static void main(String[] args) {

double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2; -
scores[2] = 6.5; €
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
scores[5] =9; //error, index out of bounds!
System.out.printin(scores);

Set values in the array with square
brackets

First item is at index O
Where is the last item?

At size-1 (index 4 here because array
size is 5)

38



Java throws an exception if try to access

memory outside the contiguous block

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores

scores[0] = 10; //zero indexed in Java
scores[1] = 3.2; Java throws an exception if you try to

access an element before or after the
array’s block of memory

scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //vak

scores[5] =9; €7/error, index out of bounds!
System.out.printin(scores);

}
}

Output

S javac MultipleVariablesArray.java
S java MultipleVariablesArray
Exception in thread "main" java.lang.ArraylndexOutOfBoundsException: Index 5 out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9) -



Memory outside the contiguous block may

be used for other purposes

Code Index 0 1 2 3 4
public class MultipleVariablesArray { ? 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8 ?
public static void main(String[] args) {

double[] scores = new double[5]; //store quiz'?(ores /
scores[0] = 10; //zero indexed in Java
scores[1] =3.2; Can you assume the memory before or
scores[2] = 6.5; after the allocated block is available for
scores[3] = 7.8; your use?

scores[4] = 8.8; //valid indices are 0..4
scores[5] =9; //error, index out of bounds! NO! The OS allocated the block of

System.out.println(scores); memory for the array and may be using
} the memory before or after for other
} purposes!
Output

C programmers can access memory

$ javac MultipleVariablesArray.java before or after, this often causes bugs!
S java MultipleVariablesArray

Exception in thread "main" java.lang.ArraylndexOutOfBoundsException: Index 5 out of bounds for length 5

at MultipleVariablesArray.main(MultipleVariablesArray.java:9) 20



Printing an array prints the starting

memory address

Code Index 0 1 2 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
double[] scores = new double[5]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5;
scores[3] =7.8;
scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!
System.out.printin(scores); €—

}
}

Output

By default, printing an array prints a value
based on the array’s starting memory address

[D@1dbd16a6
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One way to loop over array elements is to

use a C-style for loop

Code Index 0 12 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {

int numberOfScores = 5;
double[] scores = new double[numberOfScores]; //store quiz scores
scores[0] = 10; //zero indexed in Java &
scores[1] =3.2;
scores[2] = 6.5; C-style for loop
scores[3] =7.8; Three components:
scores[4] = 8.8; //valid indices are 0..4 1. Initialization
//scores[5] =9; //error, index out of boun 2. Conditional
System.out.printin(scores); Output 3. Increment

Commonly use a variable to declare array size

. S javac MultipleVariablesArray.java
nrmy,
System.out.print("["); S java MultipleVariablesArray

for (int i= 0; i < numberOfScores-1; i++) { D@1dbd16a6

System.out.print(scores[i] + ", "); [10.0,3.2,6.5,7.8, 8.8]

}

System.out.printIn(scores[numberOfScores-1] + "]");
} 42



One way to loop over array elements is to

use a C-style for loop

Code Index 0 12 3 4

public class MultipleVariablesArray { 10 ‘ 3.2 ‘ 6.5 ‘ 7.8 ‘ 8.8
public static void main(String[] args) {
int numberOfScores = 5;
double[] scores = new double[numberOfScores]; //store quiz scores
scores[0] = 10; //zero indexed in Java
scores[1] =3.2;
scores[2] = 6.5; Access array element at index i
scores[3] =7.8; using square brackets

scores[4] = 8.8; //valid indices are 0..4
//scores[5] =9; //error, index out of bounds!
System.out.printin(scores);

Note: using print not printin here

Output printin adds a new line character

. S javac MultipleVariablesArray.java
nrmy,
System.out.print("["); S java MultipleVariablesArray

for (int i= 0; i < numberOfSco D@1dbd16a6
System.out.print(scores[i] + ", "); [10.0,3.2,6.5,7.8, 8.8]

}

System.out.printIn(scores[numberOfScores-1] + "]");
} 43



Java also has multidimensional arrays

Code MultidimensionalArray.java

public class MultidimensionalArray { Store qu'? scor?s for ?everal
public static void main(String[] args) { students in 2-dimensional array

int numberOfStudents = 10; One row for each student

int numberOfQuizes = 5; One column for each quiz
double scores[][] = new double[numberOfStudents][numberOfQuizes];

__ Remember zero indexing!
Student 3 is at index 2
Quiz 2 is atindex 1

//set score for student 3 on quiz 2
scores[2][1] = 9.2; FFemember zero-indexing!

//print all scores
int quiz; «—— Can declare variable outside for loop so its scope goes beyond for loop

for (int student = 0; student < numberOfStudents; student++) {
for (quiz = 0; quiz < numberOfQuizes-1; quiz++) {

System.out.print(scores[student][quiz] + ", "); Nested loops

} Loop over each student
System.out.printin(scores[student][quiz]); loop over each quiz
} /1 print quiz score for student
}
} Because quiz declared outside for loop, it is still in scope

here (would be out of scope if declared as part of for loop) 44



Arrays holding numeric values are

initialized to zero

Code MultidimensionalArray.java
public class MultidimensionalArray { Java initializes numeric
public static void main(String[] args) { array values to zero

int numberOfStudents = 10;
int numberOfQuizes = 5;
double scores[][] = new double[numberOfStudents][numberOfQuizes];

//set score for student 3 on quiz 2
scores[2][1] = 9.2; //remember zero-indexing!

\

Output

$ javac MultidimensiohalArray.java
S java MultidimensiogpalArray
0.0, 0.0, 0.0, 0.0, 0.0

Value set
//print all scores

int quiz; 0.0, 0.0, 0.0, 0.0
for (int student = 0; student < numberOfStudents; student++) { 0.0,9:2,0.0,0.0,0.0

. . . : 0.0, 0.0, 0.0, 0.0, 0.0
for (quiz = 0; quiz < numberOfQuizes-1; quiz++) { 0.0.00. 00 0.0 00

System.out.print(scores[student][quiz] + ", "); 0.0, 0.0, 0.0, 0.0, 0.0
} 0.0, 0.0, 0.0, 0.0, 0.0

. . 0.0, 0.0, 0.0, 0.0, 0.0
System.out.println(scores[student][quiz]); 0.0.00. 0.0 00 0.0

Y 0.0,0.0,0.0, 0.0, 0.0

}
}
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Short Assignment O (SA-0) is out, complete

survey before 8:00am tomorrow

SA-0

Find assignment on Canvas

1. Take course survey to understand your background
and assign you to a section

2. Set up development environment
* [nstructions and screen shots provided on website
 We will use IntelliJ IDEA for this course

3. Create your first Java class

4. Read and acknowledge course policies and honor
code

Complete survey before 8:00am tomorrow (or risk

getting assigned to inconvenient section time!)
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Key points

1. Java is a compiled, strongly typed language
2. In Java we declare each variable and give it a data type
3. Data types cannot be changed

4. Arrays are just a contiguous block memory, (that’s all
they are!)

5. Arrays are different from Java’s ArrayLists and Python’s
lists! We will soon see how they are different
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